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COPYRIGHT 
The JET DST OBDII Tuner software is copyright 2005 with all rights 
reserved. The distribution and sale of this software are for the exclusive use 
of the original purchaser for use exclusively on computers privately owned 
by that purchaser. Unauthorized copying, duplicating, selling, or otherwise 
distributing the software is in violation of the Federal Copyright Law. 

 
LICENSE AGREEMENT  

Use of this product constitutes acceptance of these terms and conditions 
and an agreement to abide by them. This is a license agreement and not an 
agreement for sale. JET Performance Products owns, or has licensed from 
the owner, copyrights in this software. The original purchaser is granted a 
personal, nonexclusive, non-transferable license to use this software under 
the terms stated in this agreement.  You may not assign or transfer the 
software or this license without the express written consent of JET 
Performance Products. Any attempt to sublicense, assign, or transfer any of 
the rights, duties, or obligations there under is void.  You may not copy 
(except for backup purposes), modify, alter, electronically transfer, lease or 
rent the software. This license is in effect until terminated.  You may 
terminate it at any time by destroying the software. It will also terminate if 
you fail to comply with any of the terms and conditions of this agreement.  If 
the license terms are not acceptable, remove the software from your 
computer. 

 
LIMITED WARRANTY AND DISCLAIMER 

JET Performance Products warrants for a period of ninety (90) days from 
the date of delivery that the software, under normal use, will substantially 
perform as described in the documentation when used on the supported 
hardware and system software. 
 
JET Performance Products’ entire liability and your exclusive remedy under 
this warranty will be at JET Performance Products’ option, to attempt to 
correct or help you work around errors, replace the software with 
functionally equivalent software, or to refund the purchase price and 
terminate this Agreement. 
 
EXCEPT FOR PRIOR EXPRESS LIMITED WARRANTIES, JET 
PERFORMANCE PRODUCTS MAKES, AND YOU RECEIVE, NO 
WARRANTIES, EXPRESS, IMPLIED STATUTORY OR IN ANY 
COMMUNICATION WITH YOU, AND JET PERFORMANCE PRODUCTS 
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. JET 
PERFORMANCE PRODUCTS DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR FREE. 

 
LIMITATION OF LIABILITY 

IN NO EVENT WILL JET PERFORMANCE PRODUCTS BE LIABLE TO 
YOU FOR ANY DAMAGES, INCLUDING LOST PROFITS, LOST 
SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING FROM THE USE OF THE SOFTWARE, EVEN IF JET 
PERFORMANCE PRODUCTS HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 

 
 



 

 

 
Table of Contents 

Introduction .................................................................................................. 4 
Minimum PC Requirements ......................................................................... 4 
Program Installation...................................................................................... 4 
Reading The PCM ........................................................................................ 4 
Editing Calibration Files (Tuning).............................................................. 10 

Opening A Calibration File.................................................................... 10 
Editing A Calibration File...................................................................... 11 
Calibration Parameters........................................................................... 11 

Switch Type Calibration Parameters ................................................. 11 
Constant Type Calibration Parameter ............................................... 12 
2D and 3D Calibration Tables........................................................... 12 
Diagnostic Type Calibration Parameters........................................... 14 

Accessing Calibration Parameters.......................................................... 15 
Saving a Calibration File........................................................................ 16 

Programming the PCM............................................................................... 17 

JET Performance Products 

4 

 
Introduction 
The JET DST OBDII Tuner package includes a set of two programs that 
allow you to quickly and easily make calibration changes to your OBDII 
GM vehicle and the interface to connect your PC to the vehicle. The JET 
Flash program is used to read and program your vehicle’s PCM (Powertrain 
Control Module) and the DST program is used to view and edit the various 
calibration parameters.  
 
Minimum PC Requirements 
While the DST program will run on virtually any PC running Windows 95 
or later, we recommend the following minimum PC specifications: 
 

Pentium 266 
Windows 98 
64 MB RAM 
800 x 600 display resolution 
20 MB free hard drive space  
 

Program Installation 
To install the DST program, insert your JET DST OBDII CD into your CD 
ROM drive and the setup program will run automatically.  If the CD does 
not auto-start, navigate to your CD-ROM drive and double click on the 
application file named 'AUTORUN' (autorun.exe) to begin the 
installation process. Follow the on-screen directions to complete the 
installation.  

 
 
 
Reading The PCM 
The first step to tuning your OBDII vehicle is to obtain a copy of the stock 
calibration information. This information is stored in the vehicle’s PCM so 
you need to read this information from the PCM. You’ll use the  JET Flash  
program to read the PCM.   
 
Before proceeding be sure you have specified the correct Comm port that 
you will be using to communicate with the PCM. To set the correct Comm 
port, select ‘Comm Port’ from the ‘Setup’ menu.  
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This will display the following screen: 
 

 
 
Select the Comm port you wish to use and click ‘OK’. The program will 
save this selection so you don’t have to set the Comm port again unless you 
want to change to a different port.  
 
To read the calibration currently stored in the PCM, select ‘Read PCM’ 
from the ‘Tools’ menu.  
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The program will then ask for a file name to give to the calibration file that 
will be created when the PCM is read. 
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Type in a valid name for your calibration file into the ‘File name:’ box and 
click on the ‘Save’ button to continue.  
 
You can add calibration notes to your calibration file by typing the notes 
into the ‘Calibration Notes’ box in the lower half of the screen before 
clicking on the ‘Save’ button. These notes will be saved with the calibration 
information and can be viewed in both the JET Flash OBDII and DST 
programs. 
 

 
 
After clicking on the ‘Save’ button the read PCM start screen will appear. 
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Before proceeding, connect the RS-232 to OBDII converter interface to the 
Comm port on your PC. If your PC has more than one Comm port, make 
sure you connect the converter to the com port that you specified on the 
Comm Port Setup screen.   
 
Connect the other end of the converter to the ALDL diagnostics connector 
on the vehicle. (The ALDL connector is located under the dash on the 
driver’s side.)  
 
Once the cable is connected, turn the ignition key on but DO NOT start the 
engine. After turning on the ignition, wait about 10 to 15 seconds to clear 
the GM security delay before proceeding with reading.  
 
Before proceeding: 
 

1. Turn off all power consuming devices such as day time running 
light, interior lights, entertainment systems, etc. 

2. Make sure your battery is fully charged. Do not attempt to read the 
PCM with a battery charger connected.) 

3. Disable the OnStar system if installed 
 
Now click on ‘OK’ to begin the PCM read process. If all the connections 
have been properly made, the program will begin communicating with the 
PCM, sending the necessary instructions to start the memory read process.   
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The following status window will be displayed during the read process: 
 

 
 
The progress meter shows the progress on the reading of the PCM as it 
proceeds and the Status window describes what part of the process is 
currently underway. Depending on the type of vehicle and the PC you are 
using, the read will usually take about four minutes.  
 
When the FLASH read process is complete, the message shown below will 
be displayed: 
  

 
 
Click ‘OK’ to complete the PCM read and close the Read Complete 
message box. 
 
The calibration information from your PCM will now be stored on your PC. 
 
NOTE: It’s a good idea to keep a copy of the original stock calibration. 
This way, you’ll have a baseline to return to if necessary.  
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Editing Calibration Files (Tuning) 
Now that you have a copy of the stock calibration that you can view and 
edit as needed. You will use the DST program to view and edit your 
calibration files. To begin tuning, run the DST program. 
 
Opening A Calibration File 
To open a PCM Calibration file select ‘Open File’ from the  File menu or 

click on the Open File  button on the tool bar at the top of the screen.  

 
This will display the ‘Open File’ dialog box. Select the desired file and 
click the ‘OK’ button. 
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Select a calibration file and click on the ‘Open’ button to load the 
calibration file into the DST program. When you click on a calibration file 
name in the Open File screen, any notes that have been saved with the 
calibration file will be displayed in the Calibration Notes box at the bottom 
of the screen. 
 
Editing A Calibration File  
Once you have loaded a calibration file into DST program you are ready to 
begin tuning by editing the various calibration parameters. 
 
Calibration Parameters 
The JET DST program uses four different formats of calibration parameters 
to display the various calibration values. 

Switch Type Calibration Parameters 
The switch type calibration parameters are values that have only two states 
such as  on  or  off , or  Enabled  or  Disabled . This type of parameter will 
include calibration items such as ‘EGR System Enable’.  
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Constant Type Calibration Parameters 
Constant parameters represent single values or calibration constants such as 
the fan on temperature. 
 

 
  

2D and 3D Calibration Tables 
Calibration Tables are used to display a series of values that depend on one 
(2D tables) or 2 other parameters (3D tables).  
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An example of a typical 2D table would be the Knock Attack Rate Vs. 
RPM.  
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A good example of a common 3D table would be the Spark Advance versus 
Load versus RPM table. 
  

 

Diagnostic Type Calibration Parameters 
The diagnostic type calibration parameters are paremeters that control the 
operation of the OBDII diagnostics.  
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Accessing Calibration Parameters 
The calibration parameters are grouped by the parameter type as desdcribed 
above. To view and edit the various calibration parameters, select the type 
of parameter you want to work with by clicking on one of the calibration 
parameter menus at the top of the DST program screen.  
 

 
 
For example, to view constant type parameters, click on the ‘Constants’ 
menu. The constant parameters are then arranged in sub-groups according 
to function. When you click on one of the calibration parameter menus the 
sub groups are then displayed. 
 

 
  
To select the sub group you are interested in click on the sub group name to 
display all the parameters in that sub group. 
 
To make the calibration parameters easy to understand and more convenient 
to edit, the JET DST program displays all table values in correct 
engineering units rather than the binary values actually stored in the 
calibration file.  
 
You may view as many tables at once as you want. To view another table, 
simply select it from the menus. To close a table, click on the window close 
box (X) in the upper right hand corner of the table.  
 
Note: You will NOT lose any changes that have been made to a table by 
closing it. 
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The displayed table can be sized in height or width by clicking on an edge 
and dragging it to the desired size. Use the ‘Windows’ menu to arrange the 
tables you have open. 
  
Saving a Calibration File 
Once you are finished editing the calibration file you need to save it. To 
save the edited calibration file to a different file so you don’t over-write the 
original calibration file,select ‘Save As’ from the ‘File’ menu.  
 

 
 
This will display the ‘Save As’ dialog box. Select another file or type in a 
new file name and click the ‘Save’ button. 
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Programming the PCM 
To test your modified calibration you need to program the new calibration 
into your vehicle’s PCM. This is done using the JET Flash program. Run 
the JET Flash program.  
 
Click on the ‘Tools’ menu and select ‘Program PCM’ from the drop-down 
list. 
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An Open File dialog screen will then be displayed.  
 

 
 
Click on the file you want to use to program the PCM and then click on the 
‘Open’ button. This will display the Program PCM connect message. 
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WARNING  
If the programming process does not complete 

successfully it is possible to damage the PCM. Under no 
circumstances should you interrupt the programming 

process once it is started. 

 
The following are recommendations for the successful programming of 
your PCM:  

• Before programming the PCM, make sure you can successfully 
read the PCM. This is a very similar process and if that is 
successful, then the programming should also work fine. YOU 
CAN NOT DAMAGE YOUR PCM BY READING IT.  

• Make sure the car battery is in good condition and fully charged. 
DO NOT try to program the PCM with a battery charger connected 
to the car battery. The correct range of the battery voltage for PCM 
programming is relatively narrow.  
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• If you’re using a laptop, make sure the laptop battery is fully 
charged.  

• Make sure you have good connections between the PC, ALDL 
connector and the interface cable and that they are not likely to be 
unintentionally disconnected during the programming process.  

• Disable all power management functions on your PC.  
• Disable all screen savers on the PC.  
• Make sure there are no other applications (programs) running on 

your PC, including virus checkers.  
• Turn off all power consuming devices such as day time running 

light, interior lights, entertainment systems, etc. 
• Make sure your battery is fully charged. Do not attempt to program 

the PCM with a battery charger connected. 
• Disable the OnStar system if installed. 
 

Before proceeding, connect the RS-232 to OBDII converter to the Comm 
port on your PC. If your PC has more than one Comm port, make sure you 
connect the converter to the Comm port that you specified on the Comm 
Port Setup screen.   
 
Connect the other end of the converter to the ALDL diagnostics connector 
on the vehicle. (The ALDL connector is located under the dash 
on the driver’s side.) 
 
Once the cable is connected, turn the ignition key on but DO NOT start the 
engine. After turning on the ignition, wait about 10 to 15 seconds to clear 
the GM security delay before proceeding with programming.  
 
Now click on ‘OK’ to begin the PCM programming process. If all the 
connections have been properly made, the program will begin 
communicating with the PCM, sending the necessary instructions to start 
the memory programming process.   
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The programming status screen will then be displayed.  
  

 
 
The progress meter shows the progress on the programming as it proceeds 
and the Status window describes what part of the process in currently 
underway. Depending on the PC you are using, the programming will 
usually take a minute or two.  
 
When the programming process is complete, the message shown below will 
be displayed: 
  

 
 
Click ‘OK’ to complete the PCM programming and close the Programming 
Complete message box. Your PCM is now programmed with the new 
calibration and ready for testing. 
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Please Note: 

 
The JET Dynamic Spectrum Tuner is a powerful tool that makes quick and 
easy tuning of late model GM cars or trucks available to all auto 
enthusiasts. While JET Performance Products has made every effort to 
make the software as user-friendly as possible you will need a basic 
understanding of the operation of modern electronic engine control systems 
to successfully tune your vehicles. The DST program does not do the tuning 
for you. 
 
There is a wide range of good tuning information available on some of the 
automotive web sites, forum and mail lists on the internet. There are also 
some excellent boks covering the operation of these systems. 
 
The JET technical support department can answer your questions regarding 
the installation and basic use of the Dynamic Spectrum Tuner, but can not 
help you with the tuning of your particular vehicle, so please do not contact 
JET regarding specific tuning questions. Every vehicle, depending on 
equipment installed, modifications that have been made and your 
performance goals presents a unique tuning task that must be addressed 
individually. 
 
This product not legal for sale or use in CA on pollution controlled vehicles. 
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